
Introduction

Excess weight or overweight occurs when too few calories are expended and too many consumed for 
individual metabolic requirements. If you eat more than you need, the surplus energy is stored in your 
body as fat. When the amount of your body fat is excessive and unsightly, you are overweight. More 
specifically, if your weight exceeds the desirable weight by 20% or more, you are considered obese. The 
extraordinarily high prevalence of obesity in the United States -- one-fourth of American adults are 
overweight and nearly one-tenth are severely overweight -- coupled with its role as a risk factor for 
diabetes, hypertension, coronary artery disease and stroke, gallbladder disease, and some types of 
cancer, suggests that a reduction in the average weight of the general population would improve the 
Nation's health. 

Americans, in general, would benefit from a lifestyle that includes more physical activity and a diet 
containing fewer calories and less fat.

Treatment of Obesity

To lose weight, one must decrease caloric intake, increase caloric expenditure, or do both. Thus, the chief
approaches to weight reduction involve behavior change related to diet and exercise, drugs to decrease 
hunger or increase satiety, and surgical or mechanical intervention designed to reduce food intake.

Thus far, no drug therapy has induced long-term weight loss. Drugs are aimed at decreasing hunger or 
increasing satiety, usually by mimicking certain neurotransmitters or hormones that play a physiologic role
in feeding behavior. One problem is that weight lost with drug therapy is more often regained than with 
other methods, suggesting that appetite-suppressant drugs lower the set point level at which body weight 
is regulated and only secondarily suppress appetite. Regardless, weight loss would be expected to occur 
only during the period of drug therapy, suggesting the need for chronic treatment.

Surgical intervention appears appropriate only for selected persons with massive obesity or with its 
severe complications who have not responded to more conservative treatment. Jejunoileal bypass has 
been largely abandoned because of unfavorable side effects. Other procedures such as gastric balloons 
and gastric surgery, which reportedly cause substantial weight loss -- although rarely to ideal weight -- in 
morbidly obese persons, require further study before their long-term effects are known.

Weight loss reduces health risks in the obese. A combination of diet and exercise seems to be the most 
sensible approach to treatment. However, fad weight loss regimens of unscientific merit have been 
estimated, in 1981, to cost consumers $5 billion annually. While such diets attract many people's attention
they may be dangerous, especially when they provide less than the full complement of essential nutrients.

"NutriSoft Weight Perfect" is based on the US Surgeon General's Report on Nutrition and Health and 
dietary guidelines for weight reduction and prevention of obesity. It is an excellent tool to help you analyze
your food intake and obtain a more desirable weight. This program allows you to enjoy varied, balanced, 
flexible, healthful and pleasant meals while you are on a weight loss diet. NutriSoft Weight Perfect can be 
used by itself, or in conjunction with diet programs from your favorite authors. Whether you are 
vegetarian, or follow a macrobiotic diet, or enroll in a weight-loss club, etc., you will find that NutriSoft 
Weight Perfect gives you better insight into your diet and helps you make informed dietary decisions.

"Four of the six leading causes of death
-- diabetes, heart disease, cancer and obesity -- are related to nutrition        
... [but] many doctors don't ask questions about diet    
until the patient has a heart attack."    
Dr. Steve Zeisel,        
Chairman, Nutrition Department, University of North Carolina
(Associated Press)





Dietary Guidelines

To lose weight, one must decrease caloric intake, increase caloric expenditure, or do both.

Because fat contains more than twice the caloric value per gram of either protein or carbohydrate, the
general public would benefit from reduced fat intake. The Food and Nutrition Board's Committee on 
Diet and Health recommended that the fat content of the U.S. diet not exceed 30% of caloric intake. 
NutriSoft Weight Perfect calculates and displays graphic analysis of fat content for every food entry 
(approximately 10,000 items in our database and also those from user's database) as well as for your
daily food consumption. The program also lets you set a fat warning level to easily identify high-fat 
foods: when the specified percentage of energy from fat is exceeded, a red icon is displayed and 
associated with a food item.

Sugar and alcohol provide calories from carbohydrate but no other nutrients, individuals seeking to 
attain and maintain desirable body weight should use these substances sparingly. NutriSoft Weight 
Perfect separates these items into their own food groups for easy identification and avoidance.

In addition, extremely low calorie diets (300 to 400 kcal per day) should be avoided because it may be
difficult to meet essential vitamin and mineral requirements on low-calorie diets. Crash diets seldom 
work if your objective is to lose weight permanently. First, when the weight you lose is mostly body 
water, it will come back when you return to your normal routines. Second, severely restrictive diets 
are not sustainable for most people on a long-term basis. NutriSoft Weight Perfect helps you identify 
inadequate diets. It also helps you design those that are healthy, varied and balanced because the 
program lets you choose wisely from thousands of foods.

Evidence indicates that exercise burns calories, increases the proportion of lean to fat body mass, 
and, therefore, raises the metabolic rate. Increased levels of physical activity are important for 
attaining desirable body weights among the general population. The rule regarding exercising is to go 
slow and steady. NutriSoft Weight Perfect provides a convenient utility to help you determine how 
much energy you expend through common activities and exercises. As a result, you can identify those
activities that may be ineffective or those that are too strenuous. In consultation with your physician, 
you can devise an exercise program that is suitable to your physical condition.

When you design a diet for yourself, make sure that it is varied and balanced. You should choose the 
foods that you like so long as they are low in fat. Diet doesn't mean deprivation. The one simple 
adjustment you most likely need to make is: reduce fat intake.

It is better to have several small meals than few big ones. People who have large, infrequent meals 
tend to gain more weight than those who eat smaller quantities (but the same total) at regular 
intervals. NutriSoft Weight Perfect graphic analysis allows you to inspect and distribute your nutrient 
intake evenly throughout the day as desired.

Important:    The dietary guidelines contained in this program are derived from research published by US 
government agencies and by private non-profit health organizations. The nutritional guidelines in this section are for
your information only. Before adopting any diet, please obtain approval from your physician.



Disclaimer

The data and nutritional guidelines contained in this program are derived from research published by US 
government agencies and by private non-profit health organizations. The data and guidelines are 
compiled for your information only and may not be construed as medical advice or instruction. Before 
adopting any diet or exercise program, please discuss your condition with your doctor and obtain his/her 
approval.



New Features

Starting with version 3.x of all NutriSoft software products, we introduce these new features:

- professional food database containing approximately 10,000 food items (registered version),
- more sophisticated food search capability: 'not' and 'and' Boolean search; global and local search,
- quick serving amount data entry,
- quick find: locate food consumed that is highest or lowest in a particular nutrient.
- copy, cut and paste meals: editing food data is easier and easier because you can conveniently reuse 
previously edited meals.
- portable file format: NutriSoft 3.x files can be read by any NutriSoft 3.x programs; e.g., files created from 
'NutriSoft Reduce Cancer Risk 3.0' can be read by 'NutriSoft Weight Perfect 3.x'.

All previously available features are retained or improved:
- user's food database support,
- printer font selection
- screen color selection,
- graphic analysis of nutrients,
- RDA analysis,
- context sensitive help,
- set fat warning level
- sorting based on nutrient contents, etc.



About NutriSoft food database

The registered version of the food database contains approximately 10,000 food items divided into 50 or 
so food groups. You can expect to find from the most common items to the more exotic foods. The 
shareware version of the database gives you a sample of the range of foods contained in the registered 
database.

Abbreviations:
To conserve space and to make the display of food names less cluttered, we have adopted a few 
abbreviations.

NFS not further specified
ckd cooked
ckg cooking
incl include / including
excl exclude / excluding
w/ with
w/o without

Note: 
Food items containing a general or nonspecific description, for example, "Beef, not further specified" have
been assigned nutrient values for a commonly eaten form of the food or for a composite of several forms. 
Values for most items containing two or more ingredients were calculated from ingredient data using 
representative recipes.

Nutrient values associated with specific brand named products were supplied by the companies in most 
cases. When not supplied by companies, values were estimated. Estimates are based on product 
ingredient lists, or on values for similar products.

Mention of commercial products in this database is solely for identification purposes and does not 
constitute endorsement over other products not mentioned.



Main Uses of the Program

"NutriSoft Weight Perfect" can do many useful things for you:

At the simplest level, it can determine your ideal weight and recommend the most healthful levels of 
nutrient and caloric intake to you. You can browse through the extensive food database and select the 
foods that provide the nutrients you need and avoid those that have too much fat, for example. You can 
view and print graphic analysis of your diet.

However, the two of the more important uses of "NutriSoft Weight Perfect" are to analyze your current diet
and to establish a weight control plan.

A typical scenario for the former case:    you record the foods you eat at each meal during the day, then 
print out the analysis to see if your current diet is too high in fat, deficient in carbohydrate, etc.    You can 
also determine if your caloric intake is spread out rather evenly throughout the day or heavily 
concentrated at a particular meal. [Some weight control plans recommend that the caloric intake is spread
out evenly throughout the day.] Using the caloric analysis dialog box, you can also determine if too many 
calories in your diet come from protein or fat and modify your diet accordingly. Make sure you print out a 
hard copy of the analysis for a comprehensive view of your day diet. Each day's food consumption can be
saved for future use. You can save the files as Mon, Tue, Wed or 0925 (for September 25th) or day1, 
day2, etc., the program will automatically add in the file extension. Use whatever file names that you can 
easily remember.

To establish a diet plan to lose or gain weight, you prepare the menu for each day by recording the foods 
you are going to eat for each meal. For simplicity, let's assume you are going to repeat the menu cycle 
every week. In this case, you will prepare 7 files (naming them Sun, Mon, Tue, Wed, Thu, Fri and Sat) 
and record the foods you plan to eat for each meal in these files. Once these files are saved, you bring up
the Weight Control Plan dialog box. The files should show up in the right list box. You then add all 7 files 
to your plan. After adjusting your weight and activity level, you will have an accurate picture of how much 
weight you will gain or lose when you follow this plan of diet. You can go back and adjust the food data in 
the files if you find that you are eating more or less than what is required to achieve your weight goal.



RDA Analysis

The RDA figures are for the average normal and healthy people in the United States under usual 
environment stresses. Your optimal personal requirements may be different. In addition, diets should be 
based on a variety of common foods to provide other nutrients for which human requirements have been 
less well defined.

The RDA analysis is color coded as follows:

- yellow : below RDA i.e., too little
- green : within RDA i.e., just about right ( 91 - 110 % )
- magenta : above RDA i.e., more than enough
- red : well-above RDA i.e., much more than needed

In general, you should strive to achieve a balanced diet which is reflected by the green bars the analysis 
displays. Excessive consumption of certain nutrients is not desirable.

You can set your own preferred nutrient intake levels and the analysis colors are modified accordingly: a 
yellow bar is displayed when the current intake is below your desired range; green when within range; 
magenta when moderately above range and red when much higher than your preferred range.

Strictly speaking, there is no RDA for carbohydrates. However, the Food and Nutrition Board of the 
National Academy of Sciences recommends that more than half the energy requirement beyond infancy 
be provided by carbohydrates. 



Modifying the Daily Food Consumption

To modify a daily food consumption document, you first select a meal you want to record the data for. 
There are 6 meals in a day: Breakfast, Morning Snack, Lunch, Afternoon Snack, Dinner and Evening 
Snack. Select one from the left pull-down list box. 

Then you select a food group from the right hand side pull-down list box. (There are approximately 50 
food groups.) It is easy to get to the food group you want: once the input focus is at the food group combo
box (by tabbing to or clicking the mouse on this control), you can type just the first letter of the food group 
and the next group name starting with that letter will be displayed. Repeating a character will cycle all the 
group names with that starting character through the combo box.

displays food group names in normal order.

displays food group names in reverse order.

[Alternatively, instead of the Food Group mode, you can specify the Search mode from the Options menu.
Or you can use your own food database.]

Select a food item in the right listbox, click on the 'I Eat' button. This item will be recorded in the meal you 
selected.

Starting with version 2.3 of our software, you can sort the food list on any individual nutrients. Select 
either the ascending or descending order via the blue or red triangular sort icons near the lower right 
corner of the food list box, a floating menu will appear inside the listbox, you can then select the nutrient 
you would like to sort on. Once the list box is sorted, you can single click on a food item to review its 
nutrient's content. Please note that from version 3.0, the nutrient contents sorted on are normalized to be 
based on each 100g of food item; this makes direct comparison between food items easier. A sort is valid 
only for the current content of the list box, this means if you move to another food group or do another 
food search, the new content will be listed in alphabetical order (except for the search content). When the 
list box is sorted, a small square appears inside a sort icon to indicate which sort sequence is in effect.

If necessary, you can adjust the amount consumed for this food item by typing the desired amount in the 
edit control above the 'Am(oun)t. OK' button. Once the right amount has been typed in, click on 'Amt. OK' 
to confirm and record this value. (Hint: Click left or right mouse button on the window's background to 
select a standard food amount for fast adjustment of quantity.)

If a food item is not what you intended to add to a meal, you can highlight it and then click on the 'Delete' 
button to remove it from your meal.

You can display the graphic caloric analysis of a food item in a meal by selecting an entry in your meal 
food consumption then click on the graph icon. A graph will appear to show you the percentages of 
calories of this food item that come from fat, protein and carbohydrate. To review the caloric analysis of 
your day food consumption, select the 'Caloric analysis...' menu item from the 'View' menu.

Repeat the food selection process for each meal, omitting the meals where you don't eat any food.

When you are done, you can save the day food consumption data for later review or for use in your 
weight control planning.

Hint:
- You can use 'Copy Meal' and 'Paste Meal' buttons on the toolbar for fast entry of food data when the 



same foods are eaten at different meals.
- Use 'Find Max' and 'Find Min' buttons to quicky identify foods eaten that are high in fat or low in 
carbohydrate, etc.



Edit meals

If you would like to reuse a meal (or repeat a few food items) in your diet, here is a convenient way to do 
so: prepare the meal (or the food items) you plan to reuse. Copy or cut it to the clipboard; then go to 
another meal or open another day's file and paste to a new meal! The serving information is retained, not 
just the food name. When you insert a meal into a partially planned meal, the inserted food items will 
appear immediately below the currently selected food item in the receiving meal.
You can also delete all food items from a meal by using the Edit Clear All command or the Clear All icon.



Food Groups Mode

In this mode, the default mode, you will see a pull down listbox that contains approximately 50 food 
groups such as "Cookies", "Oils", "Beef", etc. By selecting any of these food groups, the food items 
belong to the group will be displayed in the list box immediately below. This mode is useful when you 
want to browse through the standard database, or when you want to do your menu planning which 
requires selection of foods from different food groups.

Since there are about 50 food groups and the average screen can display only 30 or so food groups at a 
time in a drop down list box, there are 2 icons to facilitate your viewing of the food groups. By alternating 
between these 2 icons, you can see the complete list of food groups in the drop down list box. You can 
also select a food group by typing the first character of its name when this list box has the focus.

displays food groups in normal order in drop down list box.

displays food groups in reverse order in drop down list box.



Food groups

The food groups in the standard database are:

1. MILK, Milk Drinks
2. CREAM, Cream Substitutes
3. MILK DESSERTS, SAUCES, GRAVIES
4. CHEESES
5. BEEF
6. PORK
7. LAMB, VEAL, GAME
8. POULTRY
9. ORGAN MEATS
10. SAUSAGES, LUNCH MEATS
11. FISH, SHELLFISH
12. MIXED DISHES w/ sauce
13. MIXED DISHES w/ starch
14. MIXED DISHES w/ starch and vegetables
15. MIXED DISHES w/ vegetables
16. SANDWICHES
17. FROZEN MEALS, w/ meat, poultry, fish base
18. EGGS, EGG PRODUCTS
19. LEGUMES
20. NUTS, SEEDS
21. BREADS (yeast), ROLLS, FLOUR
22. BREADS, QUICK
23. CAKES
24. COOKIES
25. PIES, PASTRIES
26. CRACKERS, SNACKS from grain products
27. PANCAKES, other grain products
28. PASTAS, COOKED CEREALS, RICE
29. CEREALS not cooked or NS
30. GRAIN MIXTURES DISHES
31. GRAIN MIXTURES, Frozen Meals
32. GRAIN MIXTURES, Soups
33. FRUITS, citrus, juices
34. FRUITS, dried
35. FRUITS, other
36. FRUIT JUICES, Nectars (non-citrus)
37. VEGETABLES, starchy
38. VEGETABLES, dark green
39. VEGETABLES, deep yellow
40. TOMATOES, tomato mixtures
41. VEGETABLES, other, raw
42. VEGETABLES, other, cooked
43. PICKLES, RELISHES, OLIVES
44. VEGETABLE SOUPS
45. VEGETABLES w/ meat, poultry, fish
46. FATS
47. OILS
48. SALAD DRESSINGS
49. SUGARS, SWEETS
50. BEVERAGES, non-alcoholic



51. BEVERAGES, alcoholic



Search mode

This is one of the most convenient features of NutriSoft programs. It allows you to find any particular food 
items from the standard and user databases without your having to browse through different categories of
food groups.

When this mode is selected, an edit control is displayed in place of the Food Group combo box and 2 
search icons are shown. You type in the name of the food item you want to find, for example "apple", then
click on one of the search icons. The list box will be filled with all food items containing "apple". You don't 
need to type in a complete word: "app" will suffice. On the other hand, when there are too many matching 
food items, you might want to restrict the match by specifying longer name such as "apple juice" or do a 
local search after having the result of the global search. The search is not case sensitive: you can use 
lower or upper case letters and this won't affect the result.

To exclude food items, use ! (the exclamation point) before the text string. Search on !spinach will 
display all items that do not have 'spinach' in their names.

The program will look for matching entries not only in the standard food database that comes with your 
software but also in your own personal food database.

The matched food items displayed in the list box can be selected as those in any other mode.

In the registered version of the software, there is no restriction on the size of the user database on which 
the search will be performed. However, memory limitation of your system might prevent the display of all 
matched entries in the list box. In this case, a message box will appear to alert you of this situation.

In the shareware version, search will be performed on the abbreviated standard database and on the first 
several records of the user database.

Global search: searches both the NutriSoft and user databases for a food item containing or not 
containing a text string. On a 486-33 system, a global search takes just under 5 seconds.

Local search: searches only the listbox's content for food items containing or not containing a text string. 
This is convenient for pruning down a previous search result which might contains hundreds of food 
items.

Tip: 
After entering the text to be searched, you can use Alt-G to do a global search or Alt-L to do a local 
search without having to use the mouse to click on a search icon.



Personal Food Database

Occasionally you may not find a food item in the standard database. What do you do when you've just 
eaten a serving of Haagen-Dazs ice cream? Or want to include a favorite ethnic TV dinner in your weekly 
plan? Most of these items do have nutritional information on their packaging. NutriSoft Weight Perfect can
access and use their nutritional information once you've entered the data into your personal food 
database. The registered version of the software does not set an upper limit on the number of food items 
in the user's personal database.

Choosing Personal Food Database from the Options menu will display all food items from your    database
in the listbox. This mode is convenient when your diet consists mainly of special food items or when you 
just want to browse the contents of your data.

The user food database is a file named 'userfood.txt'. The file can be edited using any plain text editor 
such as the Windows's notepad program. You can also use a database program such as Access, FoxPro,
or Paradox, etc. or any spreadsheet program such as Excel or Lotus 1-2-3 to create this database and 
export/save the database to/in the plain text format. 

The format of each record (entry, line) in this database is:
- food name in double quotes ( e.g., "Quarter Pounder with Cheese" )
- weight of food in grams (e.g., 250 )
- calories from food in Kcalories (e.g., 300 )
- protein from food in grams (e.g., 30)
- carbohydrate from food in grams (e.g., 150)
- total fat from food in grams (e.g., 50)

Each food item must be stored on a single line and each nutrient information is separated from one 
another by a comma so the above food item is recorded as:
"Quarter Pounder with Cheese", 250, 300, 30, 150, 50
Space(s) before or after the commas is optional.

Hint:
Please print out the file 'userfood.txt' for sample entries.



Serving amount

If necessary, you can adjust the amount consumed for a food item by typing the desired amount in grams 
in the edit control above the 'Am(oun)t. OK' button. Once the right amount has been typed in, click on 
'Amt. OK' to confirm and record this value.

For your convenience, we have provided 2 popup menus which you can use to quickly adjust the amount 
of servings:

- a left mouse button click anywhere on the background of the document window will display a selection of
common serving sizes. If the serving size is 1 cup (the serving size or unit is enclosed in square brackets,
for example, [1 cup]), selecting .5 indicates that you consume half a cup of a particular food item. How 
much half a cup weighs and the nutrient contents of this amount of food are adjusted and recorded 
automatically for you.

- a right mouse button click will display a selection of common servings in grams or ounces. When you 
release the mouse button after selecting an amount, the amount in the edit box and other data will be 
updated automatically.



Quick Serving Entry in Ounces

This option allows you to hold down the right mouse button on the main window's background and select 
one of the standard serving sizes in ounces for quick data input.



Quick Serving Entry in Grams

This option allows you to hold down the right mouse button on the main window's background and select 
one of the standard serving sizes in grams for quick data input.



Sorting:

You can quickly identify food items high or low in certain nutrients by sorting them. Since the nutrient 
values are those contained in 100g of each food item, you can directly compare different items and easily 
select the appropriate foods to meet your dietary requirement.

clicks this icon to sort the items in the listbox in ascending order. A selection menu will appear to let you 
specify which particular nutrient you want to sort on.

clicks this icon to sort the food items in descending order.

indicates the food items are sorted in ascending order, click on a food item in the listbox to see the 
nutrient's value.

indicates the food items are sorted in descending order, you can click on a food item to view the particular
nutrient's content.



Desirable Weight

This utility calculates the desirable weight based on a person's height, sex and frame. The desirable 
weight is that associated with lowest mortality.

To plan your weight loss use Weight Control Plan.

Use the spin controls in the dialog box to specify your height (without shoes) and frame. Specify your sex 
by selecting the appropriate radio button.

If you close the dialog box by clicking the OK button, the information will be saved and redisplayed next 
time you invoke the dialog box. Use the Esc key to close the dialog box without saving.



Set Fat Warning Level

"Because fat contains more than twice the caloric value per gram of either protein or carbohydrate, the
general public would benefit from reduced fat intake." 

U.S. Surgeon General

Is this food too fatty? Use this dialog box to set the threshold when the program should warn you when a 
food item exceeds the limit. A green or red symbol is displayed appropriately. You can click on the symbol 
to invoke the dialog box.

When you print out your nutritional analysis of your diet, each fatty food will also be marked with an 
asterisk for easy recognition.



Caloric Need and Nutrient Requirements

This dialog box calculates your daily caloric need and recommended intakes of important nutrients 
according to your age, ideal weight, activity level.

Specify your age, ideal weight and activity level using the spin buttons. Activity level ranges from 1 
(sedentary) to 10 (strenuous). 

Suggested total fat intake is based on the American Heart Association's and the Food and Nutrition 
Board's recommendation that no more than 30% of your calories come from fat. 

Recommended intakes of other nutrients are based on the Surgeon General's recommendation and on 
the National Research Council's data.

To leave the dialog box, click on the OK button or select Close from the dialog box's system menu or hit 
Esc. If you click OK, the current information is saved for next time you invoke the dialog box.

The dialog box must be filled out at least once: when you run the application for the first time, the dialog 
box is automatically presented to obtain your individual information. You can revise the information 
anytime.



Weight Control Plan

It's hard to achieve your weight goal without planning. This utility allows you to establish a plan and 
estimate precisely how much weight you will gain or lose when you follow this plan. 

NutriSoft weight control plan is truly flexible: you can set a food plan to be repeat every week, every 3 
days or every 10. 

Once an entry is added into your plan, you can select it then click on the 'chart' button to review its 
nutritional content. Please note that you must have previously saved some files before you can use this 
dialog box. Or you can try out the sample daily food consumption files we provide.

In general, you should not try to achieve significant weight loss in just a few days. Please consult your 
physician regarding your weight loss goal. Even an energy deficit of just 500 kcal a day should result in a 
loss of approximately 1 pound per week or 50 pounds a year!

After setting up your plan, print out a report to keep track of your food intake and to motivate yourself to 
achieve your goal.



Nutrient Analysis

Do you know which meal provides you with the most protein in your diet? With the most fat? This graph 
displays the percentage of each nutrient consumed during each meal of the day.

Select 'Protein' from the combobox and the graph shows the percentage of protein that comes from 
breakfast, morning snack, lunch, afternoon snack, dinner and evening snack in counter clockwise order. 

The analyses are provided for weight, calories, protein, carbohydrate, fat, and other essential nutrients 
when available. These analyses are very convenient when you want to spread out your energy intake 
throughout the day instead of concentrate your food consumption in infrequent big meals.

To leave the dialog box, click on the OK button or select Close from the dialog box's system menu or hit 
Esc. If you click OK, the currently selected nutrient will also be initially selected next time you invoke the 
dialog box.



Caloric Analysis

These 2 graphs provide information about the nutrient contents of your food intake for the current day or 
for that previously saved in a file.

The left graph shows the weight in grams of protein, carbohydrate and fat in the day's food consumption. 
The right graph shows the day's caloric intake and a pie chart depicting the percentages of calories from 
protein, carbohydrate and fat in counter clockwise order. Each nutrient is color coded for easy 
idenfication.

You should pay particular attention to the percentage of calories from fat. The American Heart Association
recommends that your total fat intake be no more than 30 percent of your total calories.

To leave the graphs click the mouse anywhere inside them or hit the escape key.



Set Fat Warning Level

This option allows you to specify the percentage of calories from fat above which you want to be alerted. 
For example, if you want to identify foods that has more than 50% of their calories derived from fat, you 
should set this value through the Set Fat Warning Level dialog box. From then on, each time a food item 
is consumed, a green or red symbol will be displayed to indicate whether its fat content is below or above 
the limit you set. When you print out your nutritional report, each food item exceeding this limit is also 
flagged with an asterisk before its name.

indicates food item does not exceed user-specified percentage of calories from fat.

indicates food item exceeds user-specified percentage of calories from fat.



Set Nutrient Intake Preference

How much of each nutrient do you want to consume each day? The color of the RDA analysis bars will 
reflect your preference. The bars are green when you consumption is within your preferred range, yellow 
when you are not having enough of a nutrient, magenta when your intake is somewhat above the optimal 
range, and red when the consumption is considerably higher than desired.

Click on the Use RDA button if you want the Recommended Daily Allowance value for any particular 
nutrient. Please note that the RDA values are for an average individual. You might need to adjust your 
optimal intake accordingly.



Caloric Analysis

Do you need a more healthful diet? This menu item displays a graph showing the number of calories in 
your diet that comes from protein, carbohydrate or fat.



Nutrient Analysis

Are you eating too much at dinner and not enough at breakfast? Check out the relative nutrient intakes of 
all your daily meals.



Weight Control Plan

It is now so easy to establish a sensible plan to control your weight. Your plan can be set for any number 
of days. Find out how much weight you will gain or lose in a week, a month or a year; and whether you 
are consuming too much fat in your plan.



Caloric Need

Find out how many calories you need a day based on your age, desirable weight and activity level. The 
dialog box also shows the maximum recommended fat consumption in your diet.



Desirable Weight

This menu item displays a dialog box which allows you to determine your ideal weight based on your sex, 
height and body frame.



Find Food Item with Lowest Content of a Nutrient

Click this button to search for food item in your day consumption that has the lowest amount of a 
particular nutrient. The food item is highlighted and the meal where it is consumed is selected. This is 
useful when you want to keep the consumption of a particular nutrient low. For example, you can find food
items with lowest fat content and consume more of these items without worrying about quickly increasing 
your fat intake. If your day's consumption has several items with the same low fat content in different 
meals, the program cycles through these items each time you click on this button.



Find Food Item with Highest Content of a Nutrient

Click this button to search for food item in your day consumption that has the highest amount of a 
particular nutrient. The food item is highlighted and the meal where it is consumed is selected. This is 
very useful when you want to quickly lower or raise the consumption of a nutrient. For example, your day 
consumption is too high in fat. You can use this button to identify the food item that most contributes to the
high fat content and adjust your consumption of this item accordingly.



Choose Printer Font

Use this option to select the printer font for your Nutritional Analysis Report and Weight Planning Report.



Choose Screen Color

Some monitors flicker noticeably when certain colors are displayed. Use this option to select the most 
pleasing color for your screen background.



Body Mass Index

Are you thin, or are you overweight? This dialog box uses the Body Mass Index (BMI) which is derived 
from your height (without shoes) and weight (without clothes) to chart your precise standing. Compare 
your BMI with that of an average person, or an obese individual.



Caloric Expenditure of Common Activities

This utility allows you to calculate how many calories you burn by exercising or by doing many of the 
usual daily activities. The registered database contains information on 130 common activities. You should 
select an activity and set it (via the 'Set Favorite Activity' button) as your favorite activity. Once this has 
been set, each time you consume a food item its caloric equivalence in terms of your favorite activity is 
calculated and displayed on the status bar at the bottom of your screen. For example, you set Tennis as 
your favorite activity and you weigh 160 lbs.; when you drink a cup of milk, the caloric equivalence of this 
food item is 18 minutes of Tennis. This means it takes you 18 minutes of playing tennis to burn away the 
calories contained in one cup of milk!

Another interesting piece of information the Caloric Expenditure dialog box provides is how much exercise
it takes to lose one pound of weight. Let's say you weigh 155 lbs. and usually play tennis for an hour each
time you get to play. The dialog box figures out you need to repeat this activity (an hour of tennis) 7 times 
to burn away one pound of weight, everything else being equal. Please note that this is not an advice for 
you to go out and play tennis 7 times to achieve this weight reduction! The information is presented so 
that you can have another measure of the relationship between weight loss and physical exercise. Before 
embarking on any excercise program, you should obtain approval from your doctor.



Dialog Boxes

Set Fat Warning Level
Establish Weight Reduction Plan
Choose Screen Color
Choose Printer Font
Set Nutrient Intake Preference
Find Desirable Weight
Find Caloric and Nutrient Requirements
Caloric Analysis
Nutrient Analysis
Body Mass Index
Caloric Expenditure



Glossary

Carbohydrate: One of the three nutrients that supply calories (energy) to the body. Carbohydrate 
provides 4 calories per gram -- the same number of calories as pure protein and less than half the 
calories of fat. Carbohydrate is essential for normal body function. There are two basic kinds of 
carbohydrate -- simple carbohydrate (or sugars) and complex carbohydrate (starches and fiber). In 
nature, both the simple sugars and the complex starches come packaged in foods like oranges, apples, 
corn, wheat, and milk. Refined or processed carbohydrates are found in cookies, cakes, and pies, etc.

Fat: One of the three nutrients that supply calories to the body. Fat provides 9 calories per gram, more 
than twice the number provided by carbohydrate or protein. In addition to providing calories, fat helps in 
the absorption of certain vitamins. Small amount of fat are necessary for normal body function.

Total fat: The sum of saturated, monounsaturated, and polyunsaturated fats present in food. A mixture of 
all three in varying amounts is found in most foods.

Gram: A unit of weight. There are about 28 grams in 1 ounce. Dietary fat, protein, and carbohydrate are 
measured in grams.

Protein: One of the three nutrients that supply calories to the body. Protein provides 4 calories per gram, 
which is less than half the calories of fat. Protein is an essential nutrient that becomes a component of 
many parts of the body, including muscle, bone, skin, and blood.

Recommended Dietary Allowances (RDAs): the levels of intake of essential nutrients that, on the basis 
of scientific knowledge, are judged by the Food and Nutrition Board to be adequate to meet the known 
nutrient needs of practically all healthy persons. [Individuals with special nutritional needs are not covered
by the RDAs.]



Questions and Answers

Q. What are the benefits of registering this software?
A. 
1. Registered users receive an upgraded diskette having an expanded database containing approximately
10,000 food items. The shareware version has a smaller database, approximately 800 items.

2. To reduce the download time from BBS and other online services, a full User's Guide (about 30 pages) 
in the Windows write format is sent only to registered users. 

3. The registered version of the software processes all food items in the user's personal database. In the 
shareware version, you can prepare as large a personal food database as you have data for but the 
program makes use of (sorts, searches or displays) only the first 10 entries in this database.

4. In addition to free technical support, registered users receive deep discount on future registrations of 
NutriSoft products. Fee for upgrading to later version of the same program is also minimal.

Q. How much does it cost to upgrade to newer versions of NutriSoft products?
A. Registered users automatically receive a free upgrade when there is a minor revision of a product. For 
example, users of Control Hypertension 2.2 automatically receive a free copy of Control Hypertension 2.3.
When there is a major new release, the standard upgrade cost is 20% of the registration fee. For 
example, registered users of Weight Perfect 2.0 can upgrade to Weight Perfect 3.0 for $7 which is 20% of
the $35 registration fee of this product.

Q. Is there printed manual for this product?
A. Because of frequent updates to our programs, we provide only online documentation: this help file (and
the file manual.wri to registered users). While reading this help file you can print out any topic as needed 
via the 'Print topic' command from the 'File' pull-down menu. Registered users can also use Windows 
write to print out the manual.

Q. Where can I obtain other NutriSoft shareware products for evaluation?
A. We encourage you to obtain other NutriSoft products from your current shareware distributor or BBS. A
complete selection of our software can also be downloaded from:

1. the Windows Shareware Forum and Health and Fitness Forum on CompuServe (please search on 
contributor: 71563,124)
2. the Windows Forum on America Online (please search on keyword: NutriSoft)
3. the Center for Innovative Computer Applications ftp site of Indiana University: ftp.cica.indiana.edu 
(in directory pub/pc/win3/misc)



About NutriSoft

NutriSoft was established by a group of Stanford University researchers to provide consumers with quality
software to help them achieve better health. Your suggestions and comments on our products are much 
appreciated. Please write to us at the following addresses:

US Mail: P.O. Box 8226, Stanford, CA 94309
America Online: NutriSoft
Internet: NutriSoft@aol.com

We welcome inquiry from authors, institutions, and publishers who would like to distribute our products or 
license our software to use with their own nutritional data.

List of software products released by NutriSoft as of June, 1994:

Fat and Cholesterol Counter for Windows, v. 1.1 ($19)
This program is a perfect companion to American Heart Association's Fat and Cholesterol Counter, a 
guide for everyone who wants a more healthful diet.

Control Diabetes for Windows, v. 1.2 ($29)
Essential tool for accurate monitoring of diabetic diet.

NutriSoft Pregnancy Nutrition for Windows, v. 2.1 ($39)
The program, developed from the latest findings of the American Academy of Pediatrics and the National 
Academy of Sciences, is the best nutrition software for a mother's health and that of her child.

NutriSoft Control Hypertension for Windows, v. 2.3 ($39)
The program is based on the report of the Joint National Committee on Detection, Evaluation, and 
Treatment of High Blood Pressure. An excellent nondrug approach to treatment for and prevention of high
blood pressure.

NutriSoft Heart Perfect for Windows, v. 2.3 ($39)
The most effective dietary strategy to reduce heart disease risk.

NutriSoft Reduce Cancer Risk for Windows, v. 3.0 ($39)
Based on studies of the National Cancer Institute and US Surgeon General's dietary guidelines, this 
program can help you lower the risk of cancer from diet. The latest generation of nutrition software.

NutriSoft Weight Perfect for Windows, v. 3.0 ($35)
Indispensable to anyone who wants to achieve a more desirable weight.
[ Registered users of NutriSoft Weight Perfect version 2.0 can upgrade to this version for $7. ]



Registration Form
[This form can be printed by selecting 'Print topic' from the File pull-down menu.]

Please indicate which software product(s):

1. Fat and Cholesterol Counter for Windows v. 1.1 ($19)

2. Control Diabetes for Windows v. 1.2 ($29)

3. NutriSoft Weight Perfect for Windows v. 3.0 ($35)

4. NutriSoft Pregnancy Nutrition for Windows v. 2.1 ($39)

5. NutriSoft Control Hypertension for Windows v. 2.3 ($39)

6. NutriSoft Heart Perfect for Windows v. 2.3 ($39)

7. NutriSoft Reduce Cancer Risk for Windows v. 3.0 ($39)

Name:

Address:

City: State: Zip:

How did you obtain this NutriSoft shareware? _______________________________

Your email address, if available: _______________________________

Comments and suggestions:

Please send check or money order to
NutriSoft

P.O. Box 8226
Stanford, CA 94309

International order: please remit in U.S. currency and add $1 for airmail postage. Because of high 
processing fee from our bank, we can no longer accept personal check from a non-US bank. Please use
money order from your bank or post office.
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Program's Icons and Buttons

Fat content:

indicates food item does not exceed user-specified percentage of calories from fat.

indicates food item exceeds user-specified percentage of calories from fat.

Click on either of these icons to specify the fat percentage where you want to be warned when exceeded.

Caloric analysis:

clicks this icon to see graphic analysis of calories from fat, protein and carbohydrate for selected food 
item.

Sorting:
Nutrients are sorted based on values in 100g of food.

clicks this icon to sort the items in the listbox in ascending order.

clicks this icon to sort the food items in descending order.

indicates the food items are sorted in ascending order, click on a food item in the listbox to see the 
nutrient's value.

indicates the food items are sorted in descending order.

Food groups viewing:
Since there are more than 50 food groups in our database and an average screen can display only about 
30 food groups at a time, these buttons make it more convenient to view the food groups (when you hold 
down the mouse on the drop down listbox) by displaying them in normal order (first group first) or reverse 
order (last group first). You can select a food group by the mouse or by typing in the first letter of the food 
group's name.

displays food groups in normal order in drop down list box. Instead of clicking on this icon, you can use 
alt-n (Normal).

displays food groups in reverse order in drop down list box. Instead of clicking on this icon, you can use 
alt-r (Reverse).



indicates food groups are displayed in normal order.

indicates food groups are displayed in reverse order.

Searching:
Since there are approximately 10,000 food items in our standard database in addition to other items in 
user's database, this search facility makes it easy for you to locate any particular food by name. You can 
do a global or a local search. You can specify that the result include or exclude certain food items. 
Example: to find all foods containing 'yogurt', you type this string (without the quotes) into the edit control 
and click the global search icon. [If you don't see the search icons, you need to select Options then 
Search mode from the main menu first.] The result is displayed in the listbox below when the search is 
completed. To exclude all vanilla yogurt, you type the string '!vanilla' (without the quotes) into the edit 
control and click the local search icon. [Don't leave a space before your search text or after the 
exclamation point because blank space is significant in the search.] To narrow the result further, you can 
do another local search on the non-vanilla yogurt items; or you can proceed to another global search.

Global search: searches both the NutriSoft and user databases for a food item containing or not 
containing a text string. You can use alt-g (Global) instead of clicking on this icon.

Local search: searches only the listbox's content for food items containing or not containing a text string. 
This is convenient for pruning down a previous search result which might contains hundreds of food 
items. You can use alt-l (Local) instead of clicking on this icon.

Quick Find:
If your current day's diet is too high in fat, for example, you can use this feature to quickly locate the item 
most contribute to this problem and adjust your consumption accordingly.

locates the food item in the current day's consumption that has the highest content of a particular nutrient.

locates the food item in the current day's consumption that has the lowest content of a particular nutrient.



View menu commands

The View menu offers the following commands:

Caloric Analysis Shows graphic analysis of percentage of calories from protein, 
carbohydrate and fat.

Nutrient Analysis Shows graphic analysis of the individual nutrient contents from your
daily food consumption.

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Tools menu commands

The Tools menu offers the following commands:

Weight Control Plan Use this dialog box to set short and long-term plan for weight 
control.

Desirable Weight Determine your ideal weight based on your sex, height and body 
frame.

Caloric Need Find out your daily caloric need.



Options menu commands

The Options menu offers the following commands:

Search Mode Allow you to search for any specific food from the 
standard and personal food databases.

Food Groups Mode Display food items according to food groups.
Personal Food Database Display food items from your personal food 

database.
Choose Printer Font Select your favorite printer font for your nutritional 

and weight planning report.
Choose Screen    Color Select your favorite color for your screen 

background.
Set Nutrient Intake Preference Set your preferred ranges of nutrient intakes. The 

color of the RDA analysis bars will reflect your 
preference.

Set Fat Warning Level Set threshold beyond which you are alerted when 
a food item has more than certain percentage of 
calories from fat.

Grams Quick Input Mode Hold down the right mouse button on the window 
background will display serving amount in grams 
for quick selection.

Ounces Quick Input Mode Hold down the right mouse button on the window 
background will display serving amount in 
ounces for quick selection.



File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Print Prints a document.
Print Setup Selects a printer and printer connection.
Exit Exits program.



Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple
documents in the application window:

Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 2, ... Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new document (file) in "Reduce Cancer Risk". A document (file) contains all
the information regarding the foods you consume during a day. You can open an existing document with 
the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing document in a new window.    You can open multiple documents at 
once.    Use the Window menu to switch among the multiple open documents.    See Window 1, 2, ... 
command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

List Files of Type
Select the type of file you want to open.

Drives
Select the drive in which "Reduce Cancer Risk" stores the file that you want to open. 

Directories
Select the directory in which "Reduce Cancer Risk" stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    "Reduce Cancer Risk" suggests
that you save changes to your document before you close it.    If you close a document without saving, 
you lose all changes made since the last time you saved it.    Before closing an untitled document, 
"Reduce Cancer Risk" displays the Save As dialog box and suggests that you name and save the 
document.

You can also close a document by using the Close icon on the document's window, as shown below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When you save a 
document for the first time, "Reduce Cancer Risk" displays the Save As dialog box so you can name your 
document.    If you want to change the name and directory of an existing document before you save it, 
choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    "Reduce Cancer Risk" displays the Save As 
dialog box so you can name your document.    

Important:
You should save all your files in the directory where you install "Reduce Cancer Risk". The Weigh Control 
planner will look for them in this directory.

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:
File Name

Type a new filename to save a document with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters.    "Reduce Cancer Risk" adds the extension 
you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Important:
You should save all your files in the directory where you install "Reduce Cancer Risk". The Weigh Control 
planner will look for them in this directory.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you 
closed.    Choose the number that corresponds with the document you want to open.



Exit command (File menu)

Use this command to end your "Reduce Cancer Risk" session.    You can also use the Close command on
the application Control menu.    "Reduce Cancer Risk" prompts you to save documents with unsaved 
changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in "Reduce Cancer Risk", such as File Open.    A check mark appears next to the menu item 
when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in "Reduce Cancer Risk",

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new document.

Open an existing document.    "Reduce Cancer Risk" displays the Open dialog box, in which you 
can locate and open the desired file.

Save the active document or template with its current name.    If you have not named the 
document, "Reduce Cancer Risk" displays the Save As dialog box.

Print the active document.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the "Reduce Cancer Risk" window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main window.    If 
there is an open document window at the bottom of the main window, then some or all of the icons may 
not be visible because they will be underneath this document window.



1, 2, ... command (Window menu)

"Reduce Cancer Risk" displays a list of currently open document windows at the bottom of the Window 
menu.    A check mark appears in front of the document name of the active window.    Choose a document 
from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using "Reduce Cancer Risk" and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



Context Help command 

Use the Context Help command to obtain help on some portion of "Reduce Cancer Risk".    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.   
Then click somewhere in the "Reduce Cancer Risk" window, such as another Toolbar button.    The Help 
topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the "Reduce Cancer Risk" window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    "Reduce Cancer Risk" determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    "Reduce Cancer Risk" determines 
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Choose Font dialog box

Select your favorite font for printed report of nutritional analysis or weight control plan.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts
Toolbar:

Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>




